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FTOOL in Use 
 

 
 
 

FTOOL Authorship  
Luiz Fernando Martha 
Associate Professor 
Pontifical Catholic University of Rio de Janeiro (PUC-Rio) 
Department of Civil Engineering and 
Computer Graphics Technology Group (Tecgraf/PUC-Rio) 
Rua Marquês de São Vicente, 225, Gávea 
22453-900 - Rio de Janeiro, RJ - BRASIL 
Phone: 55+21+3114-1190 
Fax: 55+21+3114-1195 
e-mail: lfm@tecgraf.puc-rio.br 
URL: http://www.tecgraf.puc-rio.br/~lfm 
 

General Concept 
FTOOL is a program designed for instruction on the analysis of plane frame structures.  It 
fulfills a need not often explored by educational programs that usually focus on analytical 
(numerical) techniques, or by the educational versions of commercial programs.  The ob-
jective of FTOOL is to motivate learning of structural behavior.  Educational experiences 
in this area have shown that knowledge of structural behavior is essential for better un-
derstanding of the analytical methods learning process.  
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FTOOL provides a simple analysis program that merges, in the same interface, resources 
for effective creation and manipulation of the model (pre-processing), linked to a fast and 
effective code for visualization of the results (post-processing).  Users of this educa-
tional version are free to apply and re-distribute the program as they wish.  However, 
neither the author nor the PUC-Rio University or any other related institution is responsi-
ble for the incorrect use of the program and its results.  The author and PUC-Rio have no 
legal responsibility for any damage caused directly or indirectly to a person or a com-
pany, resulting from the application of any information or the utilization of the program.  
Users are responsible for all conclusions made through the program.  There is no com-
mitment of satisfactory performance or any kind of warranty. 
 

Downloading FTOOL 

•  Ftool Version 2.11 for Windows: 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftool211win.zip 

•  Ftool Version 2.11 for Linux: 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftool211linux.tgz 
the available version is compatible to library glibc 2.0 for Linux and operates li-
braries of OSF Motif (http://www.openmotif.org). 

•  Download of this guidebook in CHM (Compiled HTML Help): 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftool211pt.chm (Portuguese) 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftool211en.chm (English) 

•  Download of this guidebook in Portuguese (PDF format): 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftoolman211pt.pdf (Portuguese) 
ftp://ftp.tecgraf.puc-rio.br/pub/users/lfm/ftoolman211en.pdf (English) 

 

Background 

FTOOL (Two-dimensional Frame Analysis Tool) was initially developed through an in-
tegrated research project coordinated by Professor Marcelo Gattass from the Computer 
Department of PUC-Rio and leader of the Computer Graphics Technology Group 
(Tecgraf/PUC-Rio). Professor Gattass received support form CNPq (National Council for 
Scientific and Technologic Development). The responsiblility for the program is now 
with Professor Luiz Fernando Martha from the Department of Civil Engineering of the 
PUC-Rio. Graduate students Eduardo Thadeu Leite Corseuil, Vinícius Samu de Fi-
gueiredo and Adriane Cavalieri Barbosa, from Department of Civil Engineering of PUC-
Rio, contributed to the development of the program as research assistants from March of 
1991 until December of 1992. The program was developed originally on a DOS platform 
and went through some initial improvements until April of 1995. 
 
Waldemar Celes Filho, professor of the Computer Science Department of PUC-Rio, 
worked on development of the HED (Half-Edge Data structure) function library for the 
internal data structure. The program’s numeric module of analysis received a contribution 
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from the PhD student of PUC-Rio Ivan Fábio Menezes, (currently professor of the De-
partment of Computer Science of PUC-Rio). 
 
From 1997 to 1998, FTOOL was revised by Professor Luiz Fernando Martha, who used 
the interface system IUP and the graphics system CD, both developed by Tecgraf/PUC-
Rio. This graphics interface allows the program to be executed on both Windows and 
Unix. In February of 1998, version 2.00 was launched. Successive versions of FTOOL 
were then introduced, each one with small improvements. 
 
In August 2000, version 2.08 was also launched on the Linux platform. In version 2.09 
(January of 2001) specific procedures for supporting instruction on structural analysis 
were incorporated: inextensible and infinitely rigid members, and member end moments 
loading. In the 2.10 version (November 2001) display of influence lines were added. In 
the last version, version 2.11 (August, 2002), the definition of member cross-sections was 
improved.  
 
Other improvements include property attributes and the ability of FTOOL to import 
model attributes from other files, option to select the member side (tension or compres-
sion) to draw bending moment diagrams, and option to draw result values transversely to 
the members. Throughout its use, FTOOL has shown to be a suitable tool for engineering 
instruction and has been used in Structural Analysis, Concrete Structures and Steel Struc-
tures courses of Civil Engineering in several Brazilian and overseas universities.  
 

New features of the latest version 2.11 (August 2002) 

•  Improved definition of beam member cross-sections. Several types of cross-
sections are available, each one defined by specific parameters. Two I-shape sec-
tion tables are incorporated (Brazilian specifications).  

•  Created an option to change the member side for displaying bending moment dia-
grams. Bending moment diagrams may now be displayed on the tension side 
(Brazilian convention) or on the compression side (common U.S.A. convention) 
of the members. The adopted sign convention for bending moments is unique: 
positive moments causing compression on the top fibers and tension on the bot-
tom fibers. When adopting the tension side option, positive bending moments are 
displayed on the bottom side; and, when adopting the compression side option, 
positive bending moments are displayed on the top side. 

•  Created an option to change the member side for displaying influence lines. There 
two plotting conventions: positive influence line values plotted on the bottom side 
of member, or influence line plot convention follows corresponding internal force 
diagram convention. 

•  Created options to import global parameters (units system, visualization parame-
ters, etc.) and attributes (material and cross-section property tables, load tables, 
etc.) from another file created by FTOOL. Properties may be imported globally or 
each table may be imported individually.  
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•  Created an option to display result values along the members.  

•  Created an option to display step values on diagrams.  

•  A scaling factor was made available in the graphics interface for displaying inter-
nal force diagrams. This scale is defined in terms of units of internal force per unit 
of length.  

•  Fixed a code problem when adjusting the model image on screen. Adjustment 
now takes into account displayed diagrams to compute model image size.  

•  Fixed a problem with long file names.  
 

New features of version 2.10 (November 2001) 

•  Created influence line response mode.  

•  Created step size for querying member diagram response values.  

•  Changed member result message such that it lists result values at each step along 
a member (if a step size is defined).  

•  Created internal force sign convention message dialog.  

•  Changed display of diagram result values such that values are displayed with 
signs, with the exception of bending moment values, which by default are dis-
played with no sign. Bending moment signs may be displayed optionally.  

•  Changed display of reaction forces and moments, adding a dash line in the center 
of the arrows.  

•  Fixed a mistake in length conversion from inch to meter (used internally).  
 

New features of version 2.09 (January 2001) 

•  Created member displacement constraints. The user may specify members with 
no axial deformation or infinitely rigid members.  

•  Created member end moments loading. 

•  Implemented computation of member end rotation at hinged ends.  

•  Supports with prescribed displacements are shown with each constraint compo-
nent displayed independently (simple supports for horizontal and vertical pre-
scribed displacement and a plate for prescribed rotation).  

•  Several modifications were made to improve the quality of the model image. The 
primary one being the following: in the Windows version, the model is displayed 
in double buffering, that is, the image is updated at once on the screen, with a bet-
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ter visual result. The display of internal force diagrams was also improved: in 
each member, the diagram is offset by eventual hinges at the ends.  

 

New features of version 2.08 (August 2000) 

•  Released Linux version.  

•  Created member temperature variation loading. The user specifies a temperature 
variation at the top edge of the cross section (edge at the positive local y-axis side) 
and a temperature variation at the bottom of the cross section (edge at the negative 
local y-axis side). A new material parameter, the thermal expansion coefficient, 
and two additional cross section properties, the cross section depth and the center 
of gravity height, were added to support this capability.  

•  Created dimension lines for distance annotation on the structure image.  

•  Created an option to open a structure file using drag-and-drop operation in the 
program screen. This option only works for the Windows version.  

•  Modified the program to allow creation of attributes (material parameters and sec-
tion properties) and loads prior to creating a structure. In this way, the user may 
keep a file with the attributes and loads that are often used, as well as units and 
number formatting, and use this file as a starting point for a new structure.  

•  Fixed a mistake in the sign of bending moments that was shown in the top mes-
sage box and in the information for members that had right-to-left or top-to-
bottom orientations. The sign was not consistent with the convention that a posi-
tive bending moment causes tension in the lower fiber of the cross section (or 
right fiber for vertical members). By mistake, the sign was defined based on the 
direction of the local y axis of the member.  

 

New features of version 2.07 (April 2000) 

•  Fixed a mistake in version 2.06; it was not displaying the correct values of inter-
nal force diagrams for units different than [kN] for axial and shear forces, and dif-
ferent than [kNm] for bending moments. The values were unintentionally dis-
played using the internal units of the program.  

•  Modified the default number formatting for displacement values such that now 
the default format is an exponential number with 3 decimal places.  

•  Fixed number formatting for nodal coordinates, visualization window sizes, and 
grid steps when number formatting of length values was modified by the user.  

•  Fixed number formatting for internal force diagrams values when number format-
ting of force or moment values was modified by the user.  
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•  Modified fence selection such that, when no object is selected, selection is auto-
matically geared to beam members.  

 

New features of version 2.06 (February 2000) 

•  Created Units & Number Formatting item in the Options menu, which launches a 
dialog for units and number formatting configuration. The user may specify the 
units of each parameter in FTOOL, as well as its number formatting. There are 
options to set default SI units (International System), default US units (United 
States System), or all units in kilo-Newtons and meters. The user may overwrite 
the default unit of any parameter.  

•  Replaced Member Properties menu by Material Parameters menu and Section 
Properties menu, which handles geometric parameters of cross sections. Created 
default Concrete and Steel material parameters.  

•  Created spring supports (translation and rotation springs).  

•  Replaced vector font text display by raster font text display on the drawing win-
dow. Exported images still use vector fonts, with the exception of postscript for-
mats.  

•  Created options to display load and reaction values in addition to the load and re-
action drawings.  

•  Created an option to display loads in conjunction to the response diagrams and 
deformed configuration.  

•  Modified info message box to use multi-line texts instead of just passive label 
texts as in the previous versions. This allows the user to copy the info message to 
the clipboard and paste it into a text editor. The right mouse button may be used 
to copy the message to the clipboard.  

 

Additional Credits 

•  The first version of this manual (for version 2.07) was created by Luis Fernando 
Kaefer, PhD student of the Polytechnic School of the University of São Paulo 
(EPUSP), Department of Engineering of Structures and Foundations (PEF) and 
Laboratory of Computational Mechanics (LMC).  

•  The implementation of multiple types of transverse sections in the FTOOL was 
contributed by Christiana Niskier, graduate student in Civil Engineering in PUC-
Rio. 

•  The update of manual for version 2.11 was contributed by Pedro Cordeiro 
Marques, undergraduate student in Civil Engineering in PUC-Rio. 
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File Operations 
The File Menu 
The drop down File menu controls file operations in FTOOL. 

 
 

 
The File menu allows the user to:  
 

•  Show the Sign Convention for the internal processing associated with FTOOL 
(Sign Convention) – see details of the sign convention in the Post-Processing sec-
tion; 

•  Create a new model (New);  
•  Open a model from an existing file on a disk (Open);  
•  Save the current model in a file (Save) or under a different name (Save as); 
•  Import properties from another FTOOL file (Import Properties);  
•  Export images from the screen (Export Screen) to the Windows transfer area 

(Clipboard) or to files with specific formats;  
•  Verify the total number of members and nodes in the model (Totals);  
•  Establish the limit of the work window (Limits); 
•  Exit the program (Exit). 

 
The Import Properties option in the File menu reads all the global parameters (units sys-
tem, visualization parameters, etc.) into the current model, as well as all the attributes 
(property of materials and section tables, etc.) that exist in another file created by 
FTOOL. When this option is selected the program asks the user to indicate the file to im-
port. Attribute tables can also be imported separately (see sections Node and Member At-
tributes and Defining the Applied Loads) 
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The most commonly used commands in the File menu are arranged in a toolbar at the top 
of the screen: 
 

 
 

Exporting screen display images through the Clipboard  
For best results, follow these steps: 
 

•  Choose the option Export Screen/Clipboard in the File menu, press the  key, or 
press Ctrl+C. This will copy all images on the main screen (not just what is cur-
rently selected). 

 
•  Open the program into which you want to import the image, MS-Word for exam-

ple. In MS-Word for versions NT, 2000 or XP, select option Paste in menu Edit 
or press Ctrl+V.  It is possible to choose the option Paste Special, then, the option 
Picture. In Windows, DO NOT select the option Picture (Enhanced Metafile) – 
this creates an extremely large image. For Windows, the option Picture generates 
a small image that can be scaled by pressing the mouse button over one of the 
corners of the selected image. 

 
•  Edit the pasted figure. In Windows 95 or 98, circles resulting from rotation or 

moments might appear black when editing the figure. It has not been discovered 
how to prevent this. To correct it, select the object and change the background 
color to white (or to the color of the background). This problem does not occur for 
Windows NT, 2000 or XP. You can make the lines thicker (1/2 pt or 3/4 pt are 
good options), change the colors of lines, etc. 

 
•  If you are printing to a black and white printer, best results are obtained if the op-

tion Black and White Image is selected before exporting the image. Use the option 
Black Foreground from menu Display. 
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Model Creation and Manipulation  
The Edit Toolbar 
The Edit toolbar groups the buttons for the creation and modification of the model. 
 

 
 
For the insertion of members, nodes, or dimension lines in FTOOL, the program auto-
matically snaps the mouse cursor to an existing unit (a node or a member). The creation 
process can be facilitated by enabling a Grid of points and using the Snap feature. (See 
section on Visualization Controls). 
 

Members and Nodes 
Member and node creation is straightforward. To insert a member, select the button  
and click on two points within the model display area. Nodes are created instantly at the 
ends of the member. If the inserted member intersects an existing one, a new node at the 
intersection of the two members is created automatically and the two members are auto-
matically subdivided.  
 
In the same way, a node is created by selecting the button  and clicking with the mouse 
at a point within the model display area. If the clicked point is on an existing member, the 
member is divided in two members with insertion of the new node. 
  
The insertion of "lines" with the mouse for creation of members is made with two clicks: 
one for the first node of the member and the next click for the second node. Usually the 
creation of lines using a mouse follows the rule "press button - drag mouse – release but-
ton".  The "two clicks" method used in FTOOL allows the user to stop the insertion of 
members after the first point by clicking with the right mouse button or by pressing Esc 
on the keyboard. This type of method also allows the user to zoom in or move the draw-
ing window after entering the first node and before entering with the second, etc.  
 

Creation of Dimension Lines 
Dimension Lines are auxiliary lines used to indicate distances on the structural model. To 
insert a dimension line, select the corresponding button in the Edit toolbar and click three 
points on the screen. The two first points are the control points to specify the distance to 
be listed by the dimension. The third point defines where the dimension line will be lo-
cated. During the construction of the line, the program updates the dimension line on the 
screen until the user enters the third point.  
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The creation of a dimension line through the "three clicks" method allows the user to 
suspend the insertion of the line before entering the final points, by clicking with the right 
mouse button or by pressing Esc on the keyboard. This type of interaction also allows the 
user to zoom in or to move the viewing window after entering the first point or the sec-
ond point and before entering the third.  
 

Keyboard Mode 
After selecting the button , nodes and members can be created by entering coordinates 
into the pop-up box fields. The Tolerance value is used for the "attraction" of existing 
nodes/members (never use null value for tolerance). 
 

 
 

Selection Mode 
The button  turns on "selection" mode. In this mode, right-clicking the mouse on a 
member or node displays its attributes in a menu on the side of the screen. Use the left 
button to select an item (the program never allows members and nodes to be selected si-
multaneously).  
 
The selection of a set of members or a set of nodes can be made clicking the left button of 
mouse concurrently with the Shift key. A set of members/nodes can also be selected by 
defining an enclosing rectangle. To do this, press and hold the left button of the mouse 
and drag it to define the rectangle.  Release the mouse button to complete the rectangle.  
 
Once nodes and members are selected, actions can be executed upon them. To delete 
entities push the  button. To transform the selected entities, use the Transform menu 
(See section below). The user can also apply attributes or loads to the selected members 
or nodes – this is discussed later. 
 

Undo and Redo  
The Undo option cancels previous actions. The Redo option re-executes the last cancelled 
action. 
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The Transform Menu 
 

 
 
The Transform menu lists options to manipulate the nodes or members that have already 
been created. There are options to move (Move), to reflect (Mirror), to rotate (Rotate), to 
apply a scale factor (Scale) and to repeat the last transformation (Repeat). If the option 
Leave Original is selected, the transformation is applied on a copy of the selected entities. 
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Visualization Controls 
The Visualization Control Toolbar 
This toolbar groups all the controls for the model visualization window. 

 
 
The option to Fit and center on the screen scales the structure image to fill the screen. 
The scale of the image on the screen can be modified in several ways, the first of which 
zooms based on a defined zoom rectangle (Define a rectangle to focus the display). The 
entry of two opposing corners of the zoom rectangle is completed with "two clicks" of 
the mouse. The "two clicks" approach permits the user to cancel the visualization area 
after the first point of the rectangle by clicking with the right button of the mouse or by 
pressing Esc. If the two mouse clicks are at the same point on the screen there will be a 
"central" zoom at this point. The Zoom In icon increases the size of the model on the 
screen, while Zoom Out button decreases the size. The dial at the base of the toolbar al-
lows for real-time zoom control of the model. 
 

Coordinate Control 
In this toolbar at the bottom of the display, the (H) and (V) text fields show the size of the 
visualization window and enable the user to alter these values. The (X) and (Y) fields 
show the position of the cursor in the screen. The (Grid) check box enables the option to 
display a grid of points on the screen, and the (Snap) check box activates the "attraction" 
of the cursor to the points of the grid.  
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The Display Menu 
This menu lists all the items that may be displayed.  The user can choose the background 
color, for example.  A check mark indicates the display quantity is active.  Just click on 
list items with the mouse.  For each background color selected there are different colors 
related to the members and nodes of the model. Another option here is to work with all 
the members of the model in black and white. Thus the image of the model can be printed 
effectively on a black and white printer. Furthermore, it is possible to specify which at-
tributes should be shown on the screen during the use of the program. It is important to 
emphasize that certain options are only applied to pre-processing and others only to post-
processing.  
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Configurations 
The Options Menu 
Currently, the options in FTOOL configurable by the user include the physical unit sys-
tems and the format for numerical values. The option Units & Number Formatting within 
the Options menu accesses parameters for these configurations. 
 

 
 

Formatting Units and Numbers 
Through the sub-menu Units & Number Formatting, the user selects physical units for 
parameters used in the structural analysis and the format for the display of numerical val-
ues for these parameters. Options exist to specify units in SI (International System), US 
(American System), or units in kilo-Newtons and meters. To specify a system of units 
and the display format, select the corresponding button at the top of the box. The user can 
always switch the system of units or formatting as needed during an analysis.  
 

 
 



    Ftool – Version 2.11– Aug. 2002  Manual in English – Nov. 2003 
 

 17

Unit Systems 
The following tables show the unit systems implemented in FTOOL for each parameter 
and the corresponding factors of conversion for the units used internally by the program 
(indicated in boldface).  
 
The first unit of each parameter appears automatically when the user selects SI units (In-
ternational System) or US units (American System). 
 
The conversions for units that have ton-force (tf) are: 1 tf = 103 kg⋅g. 
 
The gravity acceleration adopted is g = 9.81 m/sec2.  
 

•  Pascal Units: 
1 Pa = 1 N/m2 
1 kPa = 103 N/m2 = 1 kN/m2 
1 MPa = 106 N/m2 = 103 kN/m2 = 1 N/mm2 
1 GPa = 109 N/m2 = 106 kN/m2 = 1 kN/mm2  
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Parameter SI units US units 

    Factor of   Factor of 
  Symbol Name ref. SI unit Symbol Name ref. SI unit 
Length m meter 1.0 ft foot 0.3048 
  cm centimeter 0.01 in inch 0.0254 
  mm millimeter 0.001       
Displacement mm millimeter 0.001 in inch 0.0254 
  cm centimeter 0.01 ft foot 0.3048 
  m meter 1.0       
Rotation rad radian 1.0 rad radian 1.0 
  deg degree π/180.0 deg degree π/180.0 
Section Size mm millimeter 0.001 in inch 0.0254 
  cm centimeter 0.01 ft foot 0.3048 
  m meter 1.0       
Section Area mm2   0.000001 in2 inch2 0.02542 
  cm2   0.0001 ft2 foot2 0.30482 
  m2   1.0       
Section inertia mm4  1.0e-12 in4 inch4 0.02544 
 cm4  1.0e-08 ft4 foot4 0.30484 
 m4  1.0    
Force kN kilo-Newton 1.0 kip kilo-pound 4.448 
 N Newton 0.001 lb pound 0.004448 

 tf ton (weight) 9.81    
Moment kNm  1.0 ft-k kip·foot 1.356 
 Nm  0.001 ft-lb foot·pound 0.001356 

 tfm   9.81 in-k inch·kip 0.11298 

 kNcm   0.01 in-lb inch·pound 0.00011298

 Ncm   0.00001       

 tfcm   0.0981       

 kNmm   0.001       

 Nmm   0.000001       

 tfmm   0.00981       
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Parameter SI units US units 

    Factor of   Factor of 
  Symbol Name ref. SI unit Symbol Name ref. SI unit 
Distributed  kN/m   1.0 k/ft kip/foot 14.593 
Load N/m   0.001 lb/ft pound/foot 0.014593 
 tf/m   9.81 k/in kip/inch 175.1 

 kN/cm   100.0 lb/in pound/foot 0.1751 

 N/cm   0.1       

 tf/cm   981.0       

 kN/mm   1000.0 kN/mm   1000.0 
  N/mm   1.0 N/mm   1.0 
  tf/mm   9810.0 tf/mm   9810.0 
Temperature °C centigrade 1.0 °F Fahrenheit (T-32)×5/9 
Elasticity MPa mega-Pascal 1000.0 ksi kip/inch2 6895.0 
Modulus GPa giga-Pascal 1000000.0 psi pound/inch2 6.895 
  tf/mm2   9810000.0 k/ft2 kip/foot2 47.878 
  N/cm2   10.0 lb/ft2 pound/foot2 0.047878 
  kN/cm2   10000.0       
  tf/cm2   98100.0       
  Pa Pascal (N/m2) 0.001       
  kN/m2 kilo-Pascal 1.0       
  tf/m2   9.81       
Specific Weight kN/m3   1.0 pcf pound/foot3 0.1571 
  N/m3   0.001 k/ft3 kip/foot3 157.1 
  tf/m3   9.81 lb/in3 pound/inch3 271.434 
 kN/cm3   1000000.0 k/in3 kip/inch3 271434.0 
 N/cm3  1000.0    
 tf/cm3  9810000.0    
  kN/mm3   1.0e+09       
  N/mm3   1000000.0       
  tf/mm3   9.81e+09       
Thermal Expan. 1/°C   1.0 1/°F   1.8 
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Parameter SI units US units 

    Factor of   Factor of 
  Symbol Name ref. SI unit Symbol Name ref. SI unit 
Translat. Spring kN/m   1.0 k/ft kip/foot 14.593 
Stiffness N/m   0.001 lb/ft pound/foot 0.014593 
 tf/m   9.81 k/in kip/inch 175.1 
 kN/cm   100.0 lb/in pound/foot 0.1751 
 N/cm   0.1       
 tf/cm   981.0    

 kN/mm   1000.0    

 N/mm   1.0    

 tf/mm   9810.0    
Rotat. Spring kNm/rad   1.0 ft-k/rad foot⋅kip/rad 1.356 
Stiffness Nm/rad   0.001 ft-lb/rad foot⋅pound/rad 0.001356 
  tfm/rad   9.81 in-k/rad inch⋅kip/rad 0.11298 
  kNcm/rad   0.01 in-lb/rad inch⋅pound/rad 0.00011298 

  Ncm/rad   0.00001 ft-k/deg foot⋅kip/deg 244.08/π 
 tfcm/rad   0.0981 ft-lb/deg foot⋅pound/deg 0.24408/π 
  kNmm/rad   0.001 in-k/deg inch⋅kip/deg 20.3364/π 
  Nmm/rad   0.000001 in-lb/deg inch⋅pound/deg 0.0203364/π 

 tfmm/rad   0.00981    

 kNm/deg   180.0/π    

  Nm/deg   0.18/π    

  tfm/deg   1765.8/π    

  kNcm/deg   1.8/π    

  Ncm/deg   0.0018/π    

 tfcm/deg   17.658/π    

 kNmm/deg   0.18/π    

 Nmm/deg   0.00018/π    

 tfmm/deg   1.7658/π    
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Node and Member Attributes 
Control of Node and Member Attributes 
The buttons of this toolbar display a set of sub-menus to create and assign properties for 
nodes and members of the model. These sub-menus appear along the side of the screen.  
 

 
 

Features Common to Sub-menus 
Sub-menus for manipulation of the material parameters, member cross-section properties 
and values of loads all have common features. The drop-down list (next figure) selects a 
set of properties that is defined by a unique name. These property values are automati-
cally shown in the sub-menus for editing.  
 

 
 
The icons shown in the next figure allow the user to manage these property sets. 
 

 
 
To create a new set of properties, select the button  and assign the new set a unique 
name. The button  imports a list of property sets from another file generated by 
FTOOL. Duplicate property sets in the imported file are ignored. The internal function 
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that compresses the property sets just eliminates those which are not in use in the current 
model. 
 

Material Parameters  
To create a new set of material parameters, select button  and specify a unique name 
(figure below to the left). Default values of material parameters are available for steel or 
concrete. 
 

 

 
Material parameters include Young’s modulus, specific weight (not currently used by 
FTOOL) and coefficient of thermal expansion (if temperature loadings are applied).  
 

Member Section Properties 
The button  creates a new set of cross-section properties. Available section types are 
shown in the drop-down list.  One of the following must be chosen: Generic, Rectangle, 
I-shape, Angle, T-shape, C-shape, Z-shape, Circle, Ring, Double angle, Box, NBR welded 
I-shapes or Usilight I-shapes. 
 

 
 
Based on the type of section selected, the parameters that define the features of that sec-
tion are then defined along the side of the screen under the schematic drawing. 
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In the case of the 
Generic section 
(shown here) the pa-
rameters listed are 
the following: 

 
•  A: Area 
 
•  I: Moment of Inertia 

(Second Moment of 
the Area) 

 
•  d: Section depth 
 
•  y : Centroid position. 
 
Defaults: only A and 
I are required. 

 

 
For the section type Pro-
file - NBR Welded-I, 
(shown here), choose the 
type of profile (Beam, 
Column or Beam-Column) 
and the depth of the sec-
tion, d.  
 
FTOOL contains data 
from NBR standard pro-
files, and will provide the 
remaining data. The user 
only needs to select spe-
cific requirements via the 
drop-down lists. 
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Support Conditions  
Through this submenu, the user defines constraints on components of displacements in 
the x and y directions and the rotation around the z-axis. The support orientation angle 
(for skew supports) is also defined, as well as any prescribed values of displacement or 
rotation. Non-rigid supports may be modeled by specifying values for corresponding 
stiffness of linear-elastic springs.  

 
 

 



    Ftool – Version 2.11– Aug. 2002  Manual in English – Nov. 2003 
 

 25

 

Connection of Member Ends to Nodes 
This sub-menu allows the user to introduce hinges at member ends or at the model nodes.  
By default, members are rigidly connected to the structure nodes. 
 

 
 

 

Constraints on Member Deformations 
This sub-menu restricts deformations within members. It is possible either to restrict axial 
deformations of a member or to consider a member as infinitely rigid.  
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Defining the Applied Loads  
 

The Load Control Toolbar  
Sub-menus are also available to define or modify various nodal and member loadings. 
These sub-menus appear along the side of the screen. The types of loads available are the 
following: concentrated loads at nodes, moments applied at nodes, moments applied at 
the ends of members, uniformly or linearly distributed loads along members, and varia-
tions of temperature applied to members.  
 

 
 

General Information 
 
•  Multiple Load Definitions 

All the loads applied to a structure act simultaneously.   
 
•  Load Definition 

The loads definition system follows the same procedures as the one that defines 
member properties. A type of load associated with a user-supplied name is created 
and added to the corresponding load list. The figure below shows a drop-down list of 
distributed loads defined by the user in a specific analysis. The values of load associ-
ated with the selected name are automatically displayed in the fields of submenu and 
can be edited.  
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The icons shown in the figure below are used to manipulate the load in a list:  
 

 
 

The current load will be applied to the selected elements (members or nodes). The 
members of interest must be selected and the load is applied through the button  
for members, or the button  for the nodes.  

 
•  Coordinate System in FTOOL 

There is a system of structural global axes in FTOOL and a system of local axes for 
each one of the members. In the global system, the X-axis is horizontal and positive 
from left to right; and the Y-axis is vertical and positive from the bottom to the top. In 
a member’s local coordinate system, the local X-axis coincides with the longitudinal 
axis of the member, with the positive direction following creation of the member; that 
is, from the initial node to the end node. The local X-axis direction can be displayed 
by selecting the Member Orientation option in the Display menu. The local Y-axis is 
perpendicular to the X-axis. The Z-axis for a member is always positive outward from 
the display.  The positive direction of local Y then follows the right-hand rule of vec-
tor cross products: Y = Z x X. 

 
•  Application of concentrated loads 

Concentrated loads (forces and moments) can be applied only on nodes of the struc-
ture. This is a current limitation of the program. If it is necessary to apply a concen-
trated load on a member, insert a new node at the desired position, thereby dividing 
the member into two members. Concentrated loads are always applied in directions of 
the global axes of the structure, positive when the forces have directions of the global 
axis, and negative when they have the opposite direction. Positive concentrated mo-
ments are applied in a counter-clockwise orientation. 

 
•  Orientation for Distributed Member Loads  

Distributed loads along a member may be specified in the framework of global coor-
dinates or in the framework of member local coordinates. The loads are positive if 
they coincide with the direction of the global or local axes.  

 
•  Partially Distributed Member Loads 

New nodes can be introduced along a member to apply distributed loads that act on a 
portion of the member length (as for concentrated loads, see above). 
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Nodal Loads 
This sub-menu allows the user to define the concentrated loads on structure nodes. It uses 
the global coordinate system.  
 

 
 

Moments Acting on Member Ends  
This sub-menu allows the user to define concentrated moments at the ends of members. 
Moments applied in a counterclockwise orientation are positive. "Ma" denotes the mo-
ment applied at the "initial" node of the member, while "Mb" is the moment applied at 
the "ending" node of the member.  
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Linear and Uniformly Distributed Loads 
This sub-menu allows the user to define linearly varying or uniformly distributed loads 
over a member.  The user can specify the global or local member coordinate system for 
the loading direction.  

 

 
 

Temperature Changes 
This sub-menu allows the user to define a linear temperature gradient over the member 
depth. The user specifies the temperature on the section’s top edge (i.e., on the positive 
side of local Y-axis) and on the bottom edge (i.e., on negative side of local Y-axis).  
FTOOL must have access to the section depth to impose this loading – even for "generic" 
sections. 
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Results 
The Results Toolbar 

 
 

 

Result Modes 
 

 
 
There are two methods to obtain and display analysis results for structures in FTOOL. 
These are the Diagram and Influence Line modes of operation. Select the desired mode of 
operation using the drop-down menu shown above. 
 
In Diagram mode, FTOOL automatically analyzes the structure as required using the 
stiffness method to construct the requested diagrams: axial forces, shear forces, bending 
moments, or deformed shape. Use the slider bar to modify the scaling of displayed dia-
grams as desired. Just clicking on the appropriate button switches the display to show the 
quantity desired. Values at locations along members can be displayed. Place the mouse 
cursor over a point on the member and click the right mouse button. Values are shown in 
a window created at the right side of the display at specified increments along the mem-
ber. 
 
In Influence Line mode, the applied loads on the structure are ignored. First click on the 
button for the desired type of influence line (e.g., shear or moment). Now place the 
mouse cursor at some point along a member and click the left mouse button. FTOOL im-
poses the required unit loading and displacement discontinuity to create the influence 
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line, which is displayed on the structural model. Move the mouse cursor to a position on 
another member and click the right mouse button. This displays numerical values of the 
influence line along that member. 
 

Sign Convention for Internal Forces and Moments  
The sign convention for internal forces and moments can be displayed in the program by 
selecting the option Sign Convention on the File menu. A window appears on the screen 
which shows the sign convention.  The user may alter the sign convention for resulting 
diagrams and influence lines. 
 

 
 
•  Top and Bottom Fibers 

The sign convention for internal forces and moments depends on the definition of the 
"lower" and "upper" fibers of the members. In horizontal and inclined members, the 
lower fibers are in the bottom when looking at the screen with the vertical axis in its 
natural position (up).  In vertical members, the lower fibers are on the right. The fig-
ure at the top of the sign convention display indicates lower fibers of a structure that 
contains members with all possible directions. 
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•  Sign Convention for Diagrams   

FTOOL adopts the following convention for the signs of the internal forces and mo-
ments and for the drawing of diagrams. 

 
� Normal forces (axial):  

Normal positive forces are tension forces.  
 

 
 
 
� Shear forces: 

Shear forces on the diagram below are positive.  
 

 
 
 

� Bending Moments: 
The sign convention shown below is adopted: positive moments causing com-
pression on the top fibers of members and tension on the bottom fibers.  Bend-
ing moment diagrams may be displayed on the tension side (Brazilian conven-
tion) or on the compression side (common U.S.A. convention) of the mem-
bers.  Use the File → Sign Convention menu to select the "tension" or "com-
pression" convention for the plotting of bending moment diagrams.  When 
adopting the tension side option, positive bending moments are displayed on 
the bottom side; and, when adopting the compression side option, positive 
bending moments are displayed on the top side 

 

 
 
 

•  Plotting Influence Lines  
Influence Lines of internal forces in the selected sections follow the sign conven-
tion explained above. The standard for plotting influence lines can be defined in 
the sign convention sub-menu. There are two options: Plot positive influence line 
values on the bottom side of member, or influence line plot convention follows 
corresponding internal force diagram convention. 
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Scaling of Diagrams and Influence Lines  
The force and moment diagrams and the deformed configuration have a default initial 
scale on the screen to create a reasonable image. This scale can be modified using the 
slider bar at the left of the Results toolbar. 
 
Similarly, the influence lines also have a single initial scale. This scale can be modified 
using the slider bar at the left of the Results toolbar. 
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Numerical Display of Results  
In Diagram mode, clicking a point on a 
member with the mouse left button dis-
plays the value of the corresponding dia-
gram for that point in the message bar 
above the drawing area. If the right button 
of mouse is used, additional information 
related to the diagram appears in the right-
most area of the screen. If a step for the 
displayed result is defined, the results of 
the diagram for the selected member will 
be shown in this area.  
 
In Diagram mode, right-click the mouse on 
a node to show the pertinent information 
for the node, such as displacements and 
support reactions. 
 
Influence line values along a member are 
displayed using the same procedure.  
 


